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Description 
Are you an AutoCAD Civil 3D software user who’s being asked to provide data to your 
geographic information system (GIS) department? Are you being asked to use GIS data as 
background data for your designs? Do you think GIS is a 4-letter word? If so, this class will 
answer this all-too-common question: “Why should I care about GIS?” You will not only learn to 
import GIS data as AutoCAD software objects, but you’ll also learn to import GIS data directly 
as AutoCAD Civil 3D software objects like Surfaces and Pipe Networks that capitalize on the 
existing database information. The request to provide design data to GIS departments is 
becoming more common every day. This class will explore the details of why just sending them 
a drawing is often not an adequate way to satisfy that request. We will explore ways to export 
AutoCAD Civil 3D software objects to GIS formats that your GIS department can use easily and 
consistently. This popular class has won the award for Best Hands-on Lab at Autodesk 
University—don’t miss your chance to learn how the GIS tools in AutoCAD Civil 3D software 
can make you more productive by automating common everyday tasks. This session features 
AutoCAD Civil 3D and AutoCAD Map 3D. 
 
Your AU Expert(s) 
Rick Ellis is the President of CADapult Software Solutions, Inc., where he provides training and 
consulting services to clients around the country, helping them get the most out of their design 
software investment. Rick specializes in AutoCAD® Civil 3D®, AutoCAD® Map 3D, Autodesk® 
InfraWorks™, AutoCAD® Raster Design, and AutoCAD®. He is a member of the Autodesk 
Developer Network, and author of several critically acclaimed books on AutoCAD Civil 3D, and 
AutoCAD Map 3D; including the Practical Guide series. Rick continues to use AutoCAD Civil 3D 
on projects in a production environment, in addition to teaching classes to organizations both 
large and small around the country.  This practical background and approach has made him a 
sought after instructor by organizations around the world. 
 
 
rick@cadapult-software.com 
@theRickEllis 

Learning Objectives 
• Learn how to create a surface in AutoCAD Civil 3D from GIS contours 
• Learn how to create a pipe network from GIS data 
• Learn how to export AutoCAD Civil 3D Objects to different GIS formats 
• Learn how to access and work with GIS data then quickly label objects with 

annotation templates 
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Introduction to GIS in Civil 3D 
In addition to all of the tools built into Civil 3D for the civil engineering workflow, the software 
also includes many powerful tools for creating, editing, importing, displaying and utilizing a wide 
range of GIS and mapping data.  For instance, aerial and satellite imagery can be displayed, 
geometric data that includes corresponding tabular data can be attached to existing AutoCAD 
objects, such as lines representing pipes and polygons representing tax lots.  Geometry with 
corresponding tabular data can also be attached to, or displayed in Civil 3D drawing files, from a 
variety of GIS sources, such as ESRI Shapefiles and Autodesk SDF.  

Many of these additional tools can be used alone, or in various combinations, and are not 
necessarily limited to GIS and mapping projects, or even civil design projects.  Unlike most Civil 
3D workflow processes, these tasks are typically not linear.  For instance, for any given project 
you may use different combinations of these tools or processes, in different sequences. 

AutoCAD Civil 3D is built on top of AutoCAD Map 3D, which is built on top of standard 
AutoCAD.  Using the many tools found in Civil 3D, you can work with three types of objects: 
standard AutoCAD objects, (such as lines, arcs, circles, polylines and blocks); Map 3D objects, 
(such as Object Data, Topologies and connected Features); and Civil 3D objects, (such as 
alignments, profiles, parcels, surfaces, and pipe networks); and. These objects that are unique 
to the Map 3D tools in Civil 3D will be explained in the Lessons and exercises to follow. 

 
I would encourage you to think of this as a toolbox that contains many related, yet separate 
tools. Each tool has its own function and purpose. As you learn and become proficient with 
these tools you become a skilled craftsman knowing what tool is best suited for each task you 
encounter during your project. I would encourage you not to limit yourself to simply the 
examples demonstrated here. Focus instead on the individual tools. There are many different 
applications for them and once you understand how to use these tools, not just blindly follow a 
series of predefined steps, then you will truly unlock the power and productivity that is available 
to you. 
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Using GIS Data from other Formats 

There are three ways that you can bring GIS data into Civil 3D: 

• Importing GIS Data as AutoCAD Objects 

• Importing GIS Data as Civil 3D Objects 

• Connecting to GIS Data 

 
Importing GIS Data as AutoCAD Objects 

AutoCAD Civil 3D can import data from a variety of sources, allowing you to edit and use the geometry 
using AutoCAD while maintaining the attribute data that may have been created in a different program. 
Without the attribute data the file will only come into the drawing as drawing objects and not contain any 
attribute information. On large areas it would be a monumental task to manually modify every object to 
contain the desired information.  

The ability to utilize data from other GIS programs inside of Civil 3D provides tremendous capabilities. 
Being able to use this data effectively requires a few simple steps. When requesting GIS data, be sure to 
get the information about the accuracy of the data and how it was created. This includes the coordinate 
system used, the definitions of the data fields, and the accuracy of the geometry.  

AutoCAD Civil 3D can import the following types: 

 
 Autodesk SDF 

 ESRI ArcInfo Coverage 

 ESRI ArcInfo Export (E00) 

 ESRI Shape file 

 GML 

 MapInfo MIF/MID 

 MapInfo TAB 

 Intergraph/MicroStation Design (dgn) 

 OS (GB) MasterMap (GML 2) 

 Spatial Data Transfer Standard (SDTS) 

 Vector Product Format Coverage (VPF) 
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Step-by-Step 
1. Start a new drawing using the ACAD.dwt template. 

2. Click the Workspace button  on the status bar and set the current workspace to 
Planning and Analysis. 

 

3. Select Ribbon: Insert ⇒ Import ⇒ 
Map Import. 

The Import Location dialog box opens. 
 

 

4. Browse to the dataset 

5. Set the Files of type to ESRI Shapefile (*.shp). 

6. Select the files Parcels.shp and Streets.shp. 

7. Click <<OK>> to continue. 
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In the Import dialog box you can configure the Layer, Coordinate Conversion, and Data options that you 
wish to use to Import each of these two Shapefiles into Civil 3D.   

 

8. Click on the Drawing Layer field in the Parcels row to activate the more <<…>> button.  
Click this button to bring up the Layer Mapping dialog box. 

Here you can choose to import the drawing objects onto an existing 
layer, create a new layer, or select a column of data from the file 
that you are importing to determine the layer names.  This last 
option will allow you to do some basic thematic mapping during the 
import of the objects.  For example, if you were importing parcel 
data and that data set had a column for zoning, you could have the 
import command create a new layer for each zoning type and place 
each parcel on the appropriate layer for its zoning designation.  
However, in this exercise you will simply import all of the parcels 
onto one layer. 

9. Choose Create on new layer and name it EX-Parcels. 

10. Click <<OK>>. 

11. Repeat the process for the Streets ShapeFile, creating 
it on a new layer named EX-Streets. 
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12. Back in the Import dialog box, click on the Data field in the Parcels row to activate the more 
<<…>> button.   

13. Click the more <<…>> button to bring up the Attribute Data dialog box. 

Here you will create Object Data from the shapefile’s 
attribute data.  You can enter the desired name for the 
Object Data Table and select the desired fields to import.  
This is the step that allows you to bring the intelligence of 
the GIS file along with the geometry into AutoCAD.  By 
creating the object data table and populating it with the 
information provided in the shape file you will be able to click 
on a parcel and find the owner name, address, zoning, and 
any other information that was added by the GIS 
department.  This will also allow you to edit the geometry 
and data from the GIS file in AutoCAD and then export it 
back to any of the supported GIS formats without losing any 
of the attached data.  If you leave the Data option set to 
None or Do not import attribute data, then you will only 
import the geometry of the file and you will lose all of the 
attached information.  The ability to convert the attribute data 
to object data is one reason the Map Import feature so 
powerful. 

 

14. Choose Create object data. 
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15. Enter Parcels for the name of the Object Data table to use. 

This will create a new Object Data Table in the drawing to store the parcel attribute data.  You can name 
this Object Data Table anything you like, but it is recommended to keep the name simple and descriptive 
to avoid confusion.  The name must be in alphanumeric characters with a maximum length of 25 
characters.  The name cannot contain spaces or symbols. 

16. Click <<OK>> to return to the Import dialog box. 

 

17. Click on the Data field in the Streets row to activate the more <<…>> button.  Click this 
button to bring up the Attribute Data dialog box.   
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18. Choose Create object data.  

19. Enter Streets for the name of the Object Data 
table to use. 

20. This time, click the <<Select Fields>> button.   

This will allow you to select only the attribute data you wish 
to import rather than the entire database. 

 

21. Deselect all fields except NAME_FULL, 
SPEED, and TYPE. 

This option allows you to be selective about what information 
you import into AutoCAD.  If you don't want to import all of 
the attached data, you have control over the columns of 
information that you import from the shape file. 

22. Click <<OK>> to return to the Import dialog box.   
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The completed dialog box should look like the one below.  If you have assigned a coordinate system to 
the drawing it will display at the top of the Import dialog box.  You can also assign a coordinate system to 
the drawing at this time by selecting the Assign Global Coordinate System button.  If a coordinate system 
has been assigned to the drawing the Input Coordinate System column will be activated.  This allows you 
to assign a coordinate system to the files that you are importing.  If the input coordinate system is 
different than the current drawing coordinate system the geometry will be converted to the current 
drawing coordinate system as it is imported. 

 

23. Click <<OK>> to begin importing the data. 

24. Zoom to Extents to view the imported objects. 
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Controlling the Display of Polygons 

Notice that the polygons are all displayed with a solid hatch fill.  This display option is a feature of the 
MPOLYGON object.  To display just the edges of the polygons you need to set the polygon display mode. 

1. At the command line enter: 
Command: POLYDISPLAY 

2. Type E to display only the edges of the polygons. 

3. Regen to redisplay the Polygons. 

4. Change the color of the layer EX-Parcels to Yellow and the later EX-Streets to Red. 
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Viewing GIS Attributes in AutoCAD 

When talking about GIS data the term attributes refers to any type of attached data, not just block 
attributes as in AutoCAD terminology.  In AutoCAD Map 3D, attribute data can be object data, external 
database data, or block attributes.  Civil 3D is built on and includes AutoCAD Map 3D which enables you 
to view and edit this attribute data, including attributes imported from GIS files, as well as attributes 
created as object data in Map 3D.  To view the attributes imported above follow these steps.   

1. Pick one of the new parcels, then right-click and select ⇒ Properties. 

2. In the Properties palette, scroll to the bottom 
and notice the attribute data from the SHP file is 
now attached to the parcel. 

You can view and edit any of the object data here as 
needed. 
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Labeling Objects with an Annotation Template 
Several types of data can be used to drive an Annotation Template. These include: 

• Object Data 
• Linked data sources 
• Object properties  

 

Any of the preceding data types and any combination of these can be used within a single Annotation 
Template, retrieving data from multiple sources of data into a single, or multiple lines of text to form part of 
the resulting label in the drawing. 

Annotation Templates are blocks with attribute tags that generate the resulting text in the drawing. All 
annotation blocks are prefixed with ACMAP_ANN_TEMPLATE followed by the name of the annotation 
template. 

 
 
Overall Process of Using Dynamic Annotation 
There are three main steps in the overall use of Dynamic Annotation.  

 
Define the Annotation Template 
This step is a one-time setup that is saved in the drawing file. After you create an annotation template, 
you can always edit it. The initial setup is often an iterative process with some aspect of trial and error to 
get the desired behavior regarding text placement on the objects, spacing of labels, and so on. 

Insert the Annotation 
After creating the annotation template, you use it to perform the actual insertion of the annotation. 

Update or Refresh Annotation 
Each time you insert annotation, the current values of the attributes that are used to generate the 
annotation are evaluated. When changes are made to the source attributes, the annotation does not 
automatically update. To reevaluate changes made to source data that drives the annotation, you must 
perform a refresh. If changes have been made to the template, which might include changes to the 
attribute sources, font settings and so on, an update is required.  

Define Annotation 
Template Insert Annotation Update or Refresh
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Step-by-Step 
Creating an Annotation Template 

1. Continue working in the same drawing. 

2. Freeze the layer EX-Streets. 

You will only label the parcels in this exercise. 

3. Select Ribbon: Annotate ⇒ Map Annotation ⇒ Define 
Template to launch the Define Annotation Template 
dialog box. 

 

4. Click <<New>> in the Annotation Template section. 

5. Name the annotation template Parcel Number, and then click <<OK>>. 

The AutoCAD Block Editor opens and the Ribbon now displays the Block Editor tab. 

6. At the command line enter: Command: MAPANNTEXT 

7. When prompted to select annotation, press Enter to create new annotation and open the 
Annotation Text dialog box. 

8. Enter Number for the Tag. 

9. Click the expression button  to the 
right of the Value field to open the 
Expression Chooser. 
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10. Expand the Object Data table Parcels. 

11. Select the field ACCTNO. 

12. Click <<OK>> to return to the 
Annotation Text dialog box. 

 

13. Enter 10 for Height in the Text Options 
section. 

14. Click <<OK>>. 

 

15. At the command line prompt Specify left point of text:  enter 0,0 and press Enter. 

The block is created at the origin, 0,0.  You may need to zoom in to see it. 

16. Select Ribbon: Block Editor ⇒ Close ⇒ Close Block Editor. 
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17. When prompted, save the changes to ACMAP_ANN_TEMPLATE_Parcel. 

 

18. Click <<OK>> in the Define Annotation Template dialog box to save the template. 

19. Save the drawing. 

Annotating Objects 

1. Select Ribbon: Annotate ⇒ Map Annotation ⇒ 
Insert. 

 

2. Select the Parcel Number Annotation template. 

3. Click <<Insert>>. 

 

4. Zoom in on and pick parcels, and then Enter to add the labels. 
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Importing GIS Data as Civil 3D Objects 
There are two types of Civil 3D objects that can be created directly from GIS data. 

• Surfaces 

• Pipe Networks 

 

 
Step-by-Step 
 

Creating a Surface from a Shapefile 
 

1. Start a new drawing from the template _AutoCAD Civil 3D (Imperial) NCS.dwt 

2. Click the Workspace button  on the status bar and set the current workspace to Civil 
3D. 

 

3. Start a new drawing from your template that contains Civil 3D styles. 

4. Select Ribbon: Home ⇒ Create Ground Data ⇒ Surfaces ⇒ Create 
Surface from GIS Data. 
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5. Enter the Name and select the desired Style. 

6. Click <<Next>>. 
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7. Set the Data source type to SHP. 

8. Browse to the dataset and select the file Contours.shp. 

9. Click <<Login>>. 

 

10. Enable the check box beside the desired Feature class. 

11. Click <<Next>>. 
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You have the option to define an area of interest if you want to limit the size of the data brought in to the 
drawing. 

12. Click <<Next>>. 
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13. Set the Civil 3D Property for the GIS Field ELEV to the elevation data field in the source file. 

14. Click <<Finish>> to create the Surface. 

You will get a warning in the Event Viewer if there are crossing breaklines in the data you are importing.  
If so, that point will be ignored and your surface should be fine.  You can zoom in and examine that 
location if you want to explore it further. 

15. Zoom Extents to view the new surface. 
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Creating a Pipe Network from a SHP 
 

1. Continue working in the drawing from the previous exercise. 

2. Expand the Ribbon: Insert tab Import panel.  

3. Click Import GIS Data. 

 

 

4. Click the folder button . 

The pipes and structures will be contained in separate SHP files.  By connecting to a folder rather than a 
specific file, then all of the SHP files in that folder will be available. 

5. Browse to the folder containing the SHP files, and click <<Open>>. 

6. Click <<Connect>> to connect to the folder, making all of the SHP files in that folder 
available. 

7. Click <<Next>> to continue through the wizard. 
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8. Name the new Pipe Network. 

9. Set the Parts list. 

10. Set the Surface name. 

11. Set the Structure label style. 

12. Set the Pipe label style. 

13. Click <<Next>>. 
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On the Schema and Coordinates panel of the wizard you will see all the SHP files in the connected folder 
along with the coordinate systems they were created in.   

14. Click <<Next>> to continue through the wizard. 
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15. Set the Imported pipe feature class to Default:Pipes (the SHP file containing the Pipe 
data). 

16. Confirm the Civil 3D pipe shape is set to Circular. 

17. Click <<Add>>. 
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18. Set the Start Structure to StructStart. 

You may need to scroll through the list of Civil 3D pipe properties to the Geometry section. 

19. Set the End Structure to StructEnd. 

20. Set the Start Invert Elevation to StartInvert. 

21. Set the End Invert Elevation to EndInvert. 

22. Set the Inner Diameter to InsideDia. 

You may need to scroll down the list of Civil 3D pipe properties to the Part Data section. 

23. Click <<Next>>. 
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24. Confirm the Imported structure feature class is set to Default:Structures (the SHP file 
containing the Structure data). 

25. Confirm the Civil 3D structure shape is set to Cylindrical. 

26. Click <<Add>>. 
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27. Set the Rim Elevation to RimElev. 

28. Set the Sump Elevation to SumpElev. 

29. Click <<Next>>. 

You will now see the No Shape Attributes 
Assigned dialog box.  This is because the SHP 
file that we are importing did not have any 
shape attributes for us to assign that could be 
matched with properties of the parts from the 
part list. 

30. Click Use the default shape with 
default shape attributes. 

 

31. Back on the Data Mapping: Structures panel of the wizard click <<Next>> again. 
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32. Confirm that Import all GIS data is selected. 

If you are importing SHP files that encompass a large area you can be selective about how much of the 
data is imported here. 

33. Click <<Next>>. 
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34. Enable the option to Snap pipe and structure tolerance. 

35. Confirm the tolerance is set to 0.0015 feet. 

36. Click <<Finish>>. 

The pipes and structures are now imported and labeled, creating a new Pipe Network. 

The Event Viewer opens to announce that the Pipe Network has been created. 

37. Close the Event Viewer. 

38. Zoom in and examine the new Pipe Network. 

You may notice the Invert In and Invert Out elevations are backwards on each of the structures with the 
Invert In lower than the Invert Out.  Next, you will reverse the pipe network to correct this issue. 

39. Select Ribbon: Modify ⇒ Design ⇒ Pipe 
Network. 

 

The Pipe Networks tab is displayed. 
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40. Expand the Ribbon: Pipe 
Networks tab Modify panel. 

41. Click Change Flow Direction. 
 

42. Select Structure (5) as the Upstream starting point. 

43. Then select Structure (1) as the Downstream ending point. 

44. The entire network should now be highlighted.  Enter to end the command and reverse the 
flow direction of the network. 

45. Regen to update the labels.   

46. Zoom in and examine the new pipe network. 
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Connecting to GIS Data  

AutoCAD Civil 3D includes the option to use FDO (Feature Data Objects), a technology that allows you to 
connect directly to GIS data, rather than import it, as we did in the example earlier. The process of 
connecting to GIS data is very different from importing it, and the resulting information that is created in 
your drawing is also different. For example, when you import GIS linear data, basic AutoCAD objects, like 
polylines, are created. When you connect to data, Features are created.  

When you import data, you are copying the 
objects into AutoCAD with no link to the 
original data. However, when you connect to 
data, there is a link to the original data, similar 
to an XREF. This means that any changes 
made elsewhere to the original data can be 
updated in your drawing. You also have the 
option to directly edit the original data if you 
are connected to it, provided you have 
permission to do so.  

Once you have learned how to use both 
methods, importing and connecting to GIS 
data, you can then decide when each method is best suited for your projects and tasks. 
 

Step-by-Step 
1. Start a new drawing from the template ACAD.dwt. 

2. Click the Workspace button  on the status bar and set the current workspace to 
Planning and Analysis. 

 

3. In the Display Manager, click the Data button, and 
then select ⇒ Connect to Data… . 
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4. From the Data Connections by Provider list, select Add SHP Connection. 

5. Change the Connection name: to Parcels. 

6. Click the SHP button . 

7. Browse to the dataset and select Parcels.shp. 

8. Click <<Connect>>. 

 

9. Once the connection is made click <<Add to Map>>. 
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Notice a new layer appears in the Display Manager and the Features appear in the drawing editor. Notice 
that all features are the same color. Next we will explore some basic display options with connected data. 

10. In the Task Pane set to Display Manager, right-click the desired layer and select Edit Style. 

The Style Editor opens, where you can modify a geospatial data layer’s style properties. Rules can also 
be set up to display the layer based on certain data conditions, zoom/scale values, etc.. 

 

11. In the Style Editor palette, click <<New Theme>>. 

This opens the Theme Polygons dialog box, where you create a theme, such as applying a different color 
value to each range of land values, resulting in a thematic map. 
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12. Set the Property to LANDVAL. 

13. Set the Distribution to Standard Deviation. 

14. Set the Number of rules to 5. 

15. For Legend Text, enter Land Value. 

16. Click <<OK>>. 

17. Close the Style Editor. 

The parcels in the drawing are themed. 
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Exporting Data to a Shapefile 

Similar to the way you imported GIS data earlier you can also export the data that you have created or 
worked with in AutoCAD Civil 3D to many different GIS data formats. This is a great way to deliver GIS 
data that you have created in AutoCAD to a client. 
 
Step-by-Step 

1. Open Taxlot Polygons.dwg from the dataset folder. 

2. At the command line enter: Command: MAPEXPORT. 

3. Navigate to the dataset folder. 

4. Select ESRI Shapefile (*.SHP) from the Files of type: list. 

5. Enter Taxlot for the File name. 

6. Click <<OK>>. 

The Export dialog box opens, where you 
select the types of object to export. In this 
exercise you will export the parcels 
represented by the polygon object type, 
and the linked data. 

7. Choose the Polygon option in 
the Object type section. 

8. Click the Select Layers button 

 in the Filter selection 
section, to select layers. 

9. Select the Taxlot_Polygon 
layer to only export the parcel 
lines. 

10. Click the Data tab. 

 

11. Click <<Select Attributes>>. 
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12. In the Select Attributes dialog box, expand 
the Object Data option. 

13. Select the Parcels object data table. 

This will export all the fields in the Parcels object data 
table.  This dialog box also allows you to drill down and 
only export selected attributes, but in this case you will 
export all of the fields. 

14. Click <<OK>> to add this information to the 
Data tab of the Export dialog box. 

 

15. Click <<OK>> to export the data. 

An Export Progress box opens to indicate progress as the objects with associated data are exported. The 
exported GIS file is created in the folder that you specified. You can review the list of files created in 
Windows Explorer. 
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Exporting Civil 3D Objects as GIS Data  
Types of Civil 3D objects that can be exported: 

• Points 
• Alignments 
• Parcels 
• Pipes 
• Structures 

 

All of the Civil 3D objects from the list above that are in your drawing will be exported, even those on 
frozen layers.  There is no way to be selective with this command about what is exported. 

The geometry of the Civil 3D objects will be exported along with all of the data created for those objects in 
Civil 3D. 

When exporting Civil 3D objects to GIS data the only file format available is the Autodesk SDF file.  If you 
need to provide the data to someone in a different format you can use the Bulk Copy command to convert 
it.    

 

Exporting Civil 3D Objects to an SDF File 

1. Open Civil 3D Data.dwg from the dataset.  This drawing contains Civil 3D data. 

2. Click the Workspace button  on the status bar and set the current workspace to Civil 
3D. 

 

3. Select Ribbon: Output ⇒ 
Export ⇒ Export Civil Objects 
to SDF. 
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4. Confirm the SDF file name is set to:  Civil 3D Data.sdf and it is located in the dataset folder. 

5. Notice the coordinate system of the drawing is included in the SDF file. 

6. Click <<OK>> to export all of the available Civil 3D Objects in the drawing to the new SDF 
file. 

The command line reports the quantity of each of the exported objects, by category. 

You have now exported Civil 3D objects to an SDF file that includes both the geometry of those objects 
and the data that was created in Civil 3D.  The SDF could be used in another program or even converted 
to a different file format using the Bulk Copy command. 

 

 

Other useful GIS tools in Civil 3D 

• Drawing Cleanup tools 

o Automate the process of cleaning many common geometry errors 

• Thematic Mapping 

• Dynamic North Arrows, Scale Bars and Legends 

• Map Books 


